V I S UA L Q U I C K s ta r t G U I D E

iCloud
Second Edition
Tom Negrino

Peachpit Press

Visual QuickStart Guide

iCloud, Second Edition
Tom Negrino
Peachpit Press
1301 Sansome Street
San Francisco, CA 94111
415/675-5100
415/675-5157 (fax)
Find us on the Web at www.peachpit.com
To report errors, please send a note to errata@peachpit.com
Peachpit Press is a division of Pearson Education
Copyright © 2013 by Tom Negrino
Editor: Clifford Colby
Production Editor: Katerina Malone
Compositor: Myrna Vladic
Indexer: Valerie Haynes Perry
Cover Design: RHDG / Riezebos Holzbaur Design Group, Peachpit Press
Interior Design: Peachpit Press
Logo Design: MINE™ www.minesf.com

Notice of Rights
All rights reserved. No part of this book may be reproduced or transmitted in any form by any
means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written
permission of the publisher. For information on getting permission for reprints and excerpts,
contact permissions@peachpit.com.
Author photo: Morgen Benoit Photography.

Notice of Liability
The information in this book is distributed on an “As Is” basis, without warranty. While every
precaution has been taken in the preparation of the book, neither the author nor Peachpit shall
have any liability to any person or entity with respect to any loss or damage caused or alleged
to be caused directly or indirectly by the instructions contained in this book or by the computer
software and hardware products described in it.

Trademarks
Visual QuickStart Guide is a registered trademark of Peachpit Press, a division of Pearson Education.
Apple, Apple TV, iCloud, iMac, iPad, iPad mini, iPhone, iPod, iPod touch, iTunes, Mac, OS X, and
Safari are trademarks of Apple Inc., registered in the U.S. and other countries.
Many of the designations used by manufacturers and sellers to distinguish their products are
claimed as trademarks. Where those designations appear in this book, and Peachpit was aware of
a trademark claim, the designations appear as requested by the owner of the trademark. All other
product names and services identified throughout this book are used in editorial fashion only and
for the benefit of such companies with no intention of infringement of the trademark. No such use,
or the use of any trade name, is intended to convey endorsement or other affiliation with this book.
ISBN-13: 978-0-321-88896-9
ISBN-10:
0-321-88896-0
9 8 7 6 5 4 3 2 1
Printed and bound in the United States of America

Dedication
To my wife, Dori, for her support and understanding of a husband who
has his cranky days. Here’s to fewer of those in the future.

Special Thanks to:
My patient editor, Cliff Colby, who instigated and shepherded this project to completion, made my work better, and encouraged me when a
challenging schedule seemed overwhelming.
Thanks to Katerina Malone, for her excellent production work.
Thanks to the book’s compositor, Myrna Vladic, and thanks to Valerie
Haynes Perry for the index.
Thanks to Peachpit’s Nancy Ruenzel and Nancy Davis for their support.
My appreciation to my friends and colleagues at Macworld magazine
for doing all that testing of iCloud features and writing about it. I’d
especially like to single out Lex Friedman, Dan Frakes, Dan Moren,
Serenity Caldwell, Kirk McElhearn, and Ted Landau for their excellent
articles. Mistakes in this book are, of course, entirely my own.

Contents at a Glance
Chapter 1

Getting Started with iCloud  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 1

Chapter 2

Working with Mail, Notes, and iMessages .  .  .  .  .  17

Chapter 3

Working with Contacts  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 49

Chapter 4

Working with Calendars and Reminders  .  .  .  .  .  . 59

Chapter 5

Using iPhoto with iCloud  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 99

Chapter 6

Using iTunes with iCloud  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  115

Chapter 7

Working with Documents in the Cloud  .  .  .  .  .  .  135

Chapter 8

Backing up to iCloud .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  149

Chapter 9

Working with Safari .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  159

Chapter 10

Using iCloud to Find People and Devices  .  .  .  .  . 173
Index  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  203

Table of Contents

v

This page intentionally left blank

Table of Contents
Chapter 1

Getting Started with iCloud .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 1
What Is iCloud?  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  2
Hardware and Software Requirements  .  .  .  .  .  .  .  .  .  .  . 7
Apple ID Considerations .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  9
Configuring iCloud on Your iOS Devices .  .  .  .  .  .  .  .  .  .  11
Configuring iCloud on Your Mac .  .  .  .  .  .  .  .  .  .  .  .  .  . 13
Configuring iCloud on Your PC  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 15

Chapter 2

Working with Mail, Notes, and iMessages  .  .  .  .  . 17
Setting up iCloud Mail Accounts on Your Mac  .  .  .  .  .  .
Setting up Mail Accounts on Your iOS Device .  .  .  .  .  . 
Working with Mail on the iCloud Website .  .  .  .  .  .  .  .  .
Working with Notes .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 
Sending iMessages .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 

Chapter 3

Working with Contacts  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 49
Searching, Adding, and Editing Contacts in iCloud .  .  . 
Working with Contact Groups .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 
Using the Action Menu .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 
Setting iCloud Contact Preferences .  .  .  .  .  .  .  .  .  .  .  .

Chapter 4

18
22
25
40
46

50
54
56
57

Working with Calendars and Reminders .  .  .  .  .  .  . 59
Setting up Calendars .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  60
Working with Calendars on the iCloud Website .  .  .  .  .  .67
Working with Events  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .73
Sharing Your Calendars with Others .  .  .  .  .  .  .  .  .  .  .  .77
Subscribing to Public Calendars  .  .  .  .  .  .  .  .  .  .  .  .  .  . 80
Setting iCloud Calendar Preferences .  .  .  .  .  .  .  .  .  .  .  83
Adding Reminders .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 85
Working with Reminders on Your iOS Device .  .  .  .  .  .  90
Managing Notifications on Mac and iOS .  .  .  .  .  .  .  .  .  94

Table of Contents

vii

Chapter 5

Using iPhoto with iCloud .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 99
Setting up Photo Stream in iCloud .  .  .  .  .  .  .  .  .  .  .  . 100
Working with Photo Stream in iPhoto .  .  .  .  .  .  .  .  .  .  .  104
Sharing Your Photo Stream .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 109
Deleting Photos .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  113

Chapter 6

Using iTunes with iCloud  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  115
Configuring iTunes in the Cloud  .  .  .  .  .  .  .  .  .  .  .  .  . 116
Configuring and Using iTunes Match .  .  .  .  .  .  .  .  .  .  .  122
Updating Your Music with iTunes Match .  .  .  .  .  .  .  .  .  130

Chapter 7

Working with Documents in the Cloud .  .  .  .  .  .  .  135
Configuring Documents in the Cloud .  .  .  .  .  .  .  .  .  .  .  136
Storing and Working with Documents in iCloud .  .  .  .  .  141
Working with iWork Documents on the
iCloud Website .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  145

Chapter 8

Backing up to iCloud  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 149
Understanding and Configuring iCloud Backup  .  .  .  . 150
Restoring an iOS Device from Backup  .  .  .  .  .  .  .  .  .  .  153
Managing Your iCloud Storage  .  .  .  .  .  .  .  .  .  .  .  .  .  .  154

Chapter 9

Working with Safari  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 159
About Bookmark Management  .  .  .  .  .  .  .  .  .  .  .  .  .  . 160
Configuring Bookmark Syncing with iCloud .  .  .  .  .  .  .  161
Using iCloud Tabs and Reading List  .  .  .  .  .  .  .  .  .  .  . 163
Useful Bookmarklets for iOS  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 169

Chapter 10

Using iCloud to Find People and Devices  .  .  .  .  .  173
Configuring iCloud Locating on the Mac .  .  .  .  .  .  .  .  .  174
Finding and Working with Your Devices  .  .  .  .  .  .  .  .  .  178
Using Find My Mac .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  187
Using Find My Friends  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  193
Using Back to My Mac  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  199

Index  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 203

viii

Table of Contents

4
Working with
Calendars and
Reminders
One of the best—and incredibly useful—
features of iCloud is its ability to keep your
calendar events and reminders in the cloud,
automatically synchronizing them among all
your devices. Imagine you’ve just finished
an appointment at the dentist, and the
receptionist asks to set up your next date.
Whipping out your iPhone, you enter the
next appointment into the Calendar app,
and in a moment, that appointment appears
on the rest of your devices.
Similarly, iCloud can create synchronized
reminders for things you need to do. With
the iOS Reminders app, you can even set
a reminder to appear only when you arrive
at a particular geographical location.
But probably the most useful feature of
iCloud calendaring is that you can share
your calendars with family, friends, and
colleagues. So when your daughter adds
her soccer practice to the family shared
calendar, it appears on the rest of the
family’s schedule as well.
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90

Managing Notifications on
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Setting up Calendars
You begin with calendars in iCloud by
creating them, in either the Mac or iOS
Calendar app (beginning in OS X 10.8
Mountain Lion, iCal’s name was changed
to Calendar to bring it in line with the
iOS equivalent). You can also create
calendars on the iCloud website A,
which I’ll discuss later in this chapter.
There’s one important concept to get
when you start managing your schedule
and to-dos with iCloud. There are two
kinds of items that iCloud deals with:
n

Events are items that appear in the body
of your calendar views. They will appear
in the Day, Week, Month, and List views.
They always have dates and times associated with them (though sometimes the
associated time is “all-day”).
Calendar list view

Day view

Calendars
List

A The Calendar application on the iCloud website has a variety of calendar views.
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n

Reminders are to-do items. They work
differently than they did with MobileMe
and the former iCal, in that you work
with them in the Mac and iOS Reminders apps, rather than with the Calendar
app. Reminders don’t appear in the
calendar views. Reminders may have a
date and time associated with them, but
don’t have to. Unlike Events, you can
also set a Priority (None, Low, Medium,
High) for a Reminder. Using a feature
called “geofencing,” they can also be
set to trigger on your iOS device when
the device is physically near a location,
using your device’s GPS and Location
Services. Even cooler, geofencing can
be set to trigger the reminder when you
arrive at or leave a particular location.
So that’s how the Siri personal assistant
built into the iPhone 4S and later can
deal with commands like “Text my wife
when I leave the office.”

In this book, I’m focusing on iCloud, rather
than working with the Mac or iOS Calendar
app, so I’ll deal mostly with working with
events on the iCloud website, rather than
in the Mac or iOS programs. However,
because Reminders are so intimately
connected with iCloud, I’ll be going into
detail with the iOS Reminders app in the
“Working with Reminders on Your iOS
Device” section, later in this chapter, and
there’s a similar section about working with
the Mac Reminders app, in the “Working
with Reminders on the Mac” section.
Mountain Lion brought changes to how
notifications work, so I’ve also added the
“Managing Notifications on Mac and iOS”
section in this edition of the book.
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The Only Good Calendar… Is Online?
Beginning with the introduction of Mountain Lion, the default (and apparently only) choice when it
comes to creating calendars is to share them with an online service. This is a change from previous
versions of iCal on the Mac; before, you could easily have both shared online calendars and private
calendars that only existed on your Mac. It’s as though Apple has decided that unshared, private
calendars are something to be avoided. I don’t quite understand why; I can easily imagine many
scenarios in which you might have calendars you only want to appear on your office machine, for
events that only occur in the office, and that don’t need to be shared with your iOS devices.
Besides iCloud, Calendar on the Mac makes it easy to create shared calendars with Google,
Yahoo, Exchange, and any server that uses the CalDAV protocol. To create a new calendar on
any of these services, you must first create the service in Calendar’s Preferences, in the Accounts
pane B. Once there, click the Plus button at the bottom of the Accounts list, then pick the kind
of account you want from the Add an Account sheet C. Enter the email address and password for
the service, then click Create.
It's actually possible to create a new calendar that is only on your Mac, but it needs a little work
around to set up. To do so, you need to open the Accounts pane of Calendar's Preferences, and
select your iCloud account in the list B. If you uncheck the Enable this account checkbox, all of
your iCloud calendars and events will disappear from Calendar on your Mac (don't worry, all the
information is still safe on iCloud). Then choose File > New Calendar, and give it a name that isn’t
the same as any of your iCloud calendars. The new calendar will be created in a section of the
calendar list that says On My Mac. Then reenable your iCloud account, and the iCloud calendar
and your private calendar will happily coexist on your computer.

B You create new shared calendar accounts in
the Accounts pane of Calendar's Preferences.
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C Pick the service you want from the Account
Type pop-up menu.

To create a calendar on a Mac:
1. Launch Calendar D.
2. Choose File > New Calendar > then
either iCloud or the name of another
shared calendar service, or On My Mac.
Choosing iCloud will place the calendar
on iCloud, where it can be shared by
your other devices and by other people.
Calendars on other services are shareable according to the particular rules of
those services (check with your system
administrator). If the calendar is on
your Mac, it will be private and will only
exist on the Mac where you created the
calendar.
3. The new calendar appears in the
Calendars List as Untitled, allowing
you to name it E. Enter the name,
then click anywhere else to save it.

D On the Mac, Calendar for OS X has a faux-leather look that people either
love or hate.

E Begin creating your
new calendar in the
Calendars list.
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To create a calendar
on an iOS device:
1. On your iPhone or iPad, start the
Calendar app.
2. Tap the Calendars button.
The Calendars (iPhone) or Show
Calendars (iPad) popover appears F.
3. Tap the Edit button.
The screen name changes to Edit
Calendars.
4. At the bottom of the iCloud section,
tap Add Calendar.
5. In the resulting Add Calendar
popover G, type the name you want
for the new calendar.
6. Tap next to the color you want the
calendar events to appear as.
You may be able to see additional
colors by scrolling.

My shared
iCloud calendars

My wife’s
calendars,
shared via iCloud
Unshared
calendar

F On the iPad, the Show Calendars popover

tells you the status of all your iCloud calendars.

7. Tap Done.
The popover will go back to the
Edit Calendars screen, and the new
calendar you created appears in
the list.
8. Tap Done.

G Type the name
you want for your
new calendar.
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To edit a calendar on a Mac:
1. In Calendar, in the Calendars List at the
upper left corner of the window, rightclick the calendar you want to change,
and choose Get Info.

H In Calendar on the Mac, each calendar has an
info dialog.

The info dialog appears for that
calendar H.
3. Do one or more of the following:
> Change the name of the calendar.
> From the color pop-up menu next
to the Name field, choose the color
in which you want the calendar’s
events to appear. One difference in
Calendar versus the Calendar app
on iOS is that one of the color choices
is Other, which when chosen brings
up a color picker that allows you to
choose any color you want, rather
than a preset color.
4. Click OK.

To edit a calendar on an iOS device:
1. On your iPhone or iPad, start the
Calendar app.
2. Tap the Calendars button.
The Calendars (iPhone) or Show
Calendars (iPad) popover appears F.
3. Tap the Edit button.
The screen name changes to Edit
Calendars.
4. In the Calendar list, tap the name of
an existing calendar.
5. In the Edit Calendar screen, change the
name or the associated color of
the calendar, then tap Done.
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Using Alternative Calendar Programs with iCloud
Just because Calendar comes with OS X, that doesn’t mean that it’s universally beloved, or even
especially liked, by people who are heavy calendar users. For those people (like me) who have
been using calendars on a computer for a very long time, and have used excellent calendar
programs over the years, Calendar is too limited, too lowest-common-denominator, for our comfort. The trouble is that all of the really useful calendar features (event synchronization between
devices, calendar sharing between people) use Calendar (or at least its data file) and iCloud as
a conduit.
Happily, if Calendar isn’t feature-rich enough for your needs, a variety of alternative calendar
programs still use the Calendar events and reminders data and provide a superior calendaring
experience. My favorite for Mac is BusyMac’s BusyCal I, which allows you to share events and
to-dos over iCloud or Google Calendar; gives you much more flexibility in calendar views; has
easier event entry than Calendar; has a wide variety of event types, such as all-day banners,
sticky notes in the calendar, and graphics; and much more.
On iOS, there are many alternatives for the Calendar app, but the ones I’ve used are called
Fantastical from Flexibits, and Calvetica J, from Mysterious Trousers. I like Calvetica because
of its minimalist design, and because it requires just a couple of taps (and the text entry for the
event name, of course) to enter an event, far fewer than Calendar. It’s fast, lets you create an
event quickly, and gets out of your way. One really attractive thing about Fantastical is that it
understands natural-language requests, so you can simply enter “Lunch next Tuesday at 2 with
Cliff” and the program correctly parses the sentence creates the calendar event. This is terrific
when combined with dictation on iOS 6.

I I prefer to use BusyCal over Calendar, because it shows me more
information at a glance, such as the mini-months, the reminders list,
and the detail for the selected event.
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J On iOS, the faster you

can enter an event the
better, which is why I prefer
Calvetica, rather than the
stock Calendar app.

Working with
Calendars on the
iCloud Website
The iCloud website gives you a great deal
of control over your calendar. With it, you
can add, view, and change events; manage
calendars; and share your calendars with
others (for that last, see the “Sharing Your
Calendars with Others” section, later in this
chapter).
In this section, all the action will take place
on the iCloud website. We’ll begin by creating, editing, and deleting calendars, then
move on to working with calendar events.
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To create a calendar:
1. Go to the iCloud website, and login
using your iCloud Apple ID and
password.
2. On the iCloud Home screen A, click
Calendar.
The Calendar screen appears B.

A On the iCloud website, click the Calendar icon
to get started.

Show/Hide
Calendars List

Go to Today

Calendar View
buttons

Notifications

Actions
pop-up menu

Year and Month selector

B You can do almost anything that you can do in Calendar on the iCloud website.
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New Event

3. Click the Actions button at the upperright of the window.
The Actions pop-up menu appears C.
4. Choose New Calendar.
A new calendar appears at the bottom
of the Calendars List, ready for you to
add a name D.

C Choose New
Calendar from
the Actions
pop-up menu.

5. Enter the name, then click outside the
name field to save it.
See “Working With Events” later in
this chapter to add and edit calendar
events.

D Type the

name of your
new calendar.

To view (or not) a calendar
or the Calendars List:
In the Calendars List, select the checkbox
next to a calendar’s name to see that’s
calendar’s contents. If the checkbox is
cleared, the events associated with that
calendar will disappear from your calendar
views. Nothing’s happened to the events;
you are simply choosing not to see them.
or
If you want to hide the Calendars List, click
the Show/Hide Calendars List button at
the top of the window. Clicking the button
again will bring the list back.
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To edit or delete a calendar:
1. In the iCloud website’s Calendar
screen, click the Edit link at the top
of the Calendars list at the upper-left
corner of the window E.

E To enter calendar
Edit mode, click the
Edit link.

The Calendars list changes into edit
mode F.
2. Do one or more of the following:
> To change the color associated with
the calendar, click the color button
next to the name of the calendar,
then choose a different color from
the popover G. You can also click the
Custom color link to pop up a more
full-featured color picker, if you don’t
like the six standard choices.

F In Edit mode,

you can change the
calendar color, the
calendar name, or
delete the calendar.

> Click in the name field of the calendar, and change it to rename the
calendar.
> To delete a calendar, click the red
button with a minus sign in it. As
usual when you’re potentially about
to destroy data, iCloud warns you
and asks if you’re sure H. If you are,
click Delete Calendar.

G Clicking the color
button brings up a
color picker.

3. When you’re done changing your
calendars, Click the Done link.
That dialog isn’t joking; remember that
iCloud is the master repository for all your
data. So if you delete that calendar, it and all
of its events will disappear not just from the
iCloud website but from all your Macs and
iOS devices as well. Be careful!
Note that a Plus button also appears
when you’re editing calendars F. Yes, that
means that it’s another way to add a calendar.
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H Make sure you really want to delete that
calendar!

To change calendar views:
On the iCloud website, you have a choice
of Day, Week, Month, or List calendar
views. Click one of the Calendar View buttons in the toolbar B to view the calendar
as you wish.

To change date views:
At the bottom of the window, you’ll find the
Date selector I. This selector changes
depending on the calendar view. For
example, if the Month view is set, you’ll
see years and months in the Date selector. If the Day or List view is set, you’ll see
individual days in the selector. Do one or
more of the following (assuming the Month
view is active; the other views are similar in
operation):
n

Click one of the months to view its
contents.
continues on next page

Previous year

Previous

Months in current year

Current year

Next year

Next

I The Date selector changes, depending on the calendar view.
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n

n

n

n

Click the Previous or Next buttons to
move to the previous or next month.
If you’re already viewing January or
December, your view will change to
the previous or next year.
Click the Previous Year or Next Year
buttons to change the calendar view
by an entire year.
Click the Today button at the lower
left corner of the window to jump to
today’s date.
If you need to view a date that’s more
than a few clicks away, click the Actions
menu C and choose Go to Date. The
resulting date picker J allows you to
type or navigate to the date you want.
Choose that date, then click OK.
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J You can jump to dates many
months or years away with this
date picker.

Working with Events
The Calendar application on the iCloud
website makes it easy to create or change
events. Its abilities are very similar to
Calendar on the Mac or the iOS Calendar
app, but there are a couple of differences.
With the website, you can’t mark an
event as one that shows that you are
Busy or Free.

To create an event:
1. In the Calendars List, click to select the
calendar in which you want to create
the event.
2. Do one or more of the following, and
the New Event popover appears:
> In Month view, double-click in the
day in which you want the event.
> In Day, Week, or List view, drag the
mouse cursor across a time range
to create an event that covers
that range.
> In any view, click the New Event
button (it looks like a plus) in the
lower-right corner of the window.
When you do this, the event is
created on the date you last
selected in the calendar.
> From the Actions pop-up menu,
choose New Event.
continues on next page
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3. In the New Event popover K, do one or
more of the following:
> Enter the title of the event.
> (Optional) Enter the event’s location.
> (Optional) If the event is going to last
all day, click the all-day checkbox.
> In the From section, set the event’s
starting date and time.
> In the To section, set the event’s ending date and time.
> (Optional) If this will be a recurring
event, choose the recurring schedule from the pop-up menu next to
Repeat. You can choose Every Day,
Every Week, Every Month, Every Year,
or Custom. If you choose Custom,
you get a pop-up dialog that allows
you to choose dates with any flexibility you want on a Daily, Weekly,
Monthly, or Yearly basis. The Monthly
or Yearly Custom choices also allow
you to choose intervals such as the
first, second, third, fourth, or last days
of a month.
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K Get to know the New Event popover well,
because you’ll be seeing it a lot.

L One of the places that alerts can appear is on
the iCloud website.

> (Optional) If you want to be reminded
before the event starts, choose from
the Alert pop-up menu, and select
the interval before the event. If you
set an alert, a 2nd Alert pop-up menu
appears, allowing you to set an
interval for a second reminder. Alerts
appear as notifications on your iOS
devices, and also in Calendar on your
Mac, and as a dialog on the iCloud
website in your browser L.
> (Optional) If you want, you can
change the calendar for the event
with a pop-up menu in the Calendar
section.
> (Optional) If you want to invite friends
or colleagues to the event, enter their
name or email address into the Invitees field. As you type, iCloud looks
up a matching contact in your iCloud
contacts list, providing a pop-up
menu with possible matches. Select
a contact from the menu to accept it.
You can add multiple invitees to an
event. If your invitees use iCloud, the
invitation will appear in the Notifications button on the iCloud website,
in Calendar, and in the Calendar app
on their iOS devices. Invitees have
the option to Accept, Decline, or mark
the event as Maybe.
> (Optional) You can also add a note to
the event, perhaps with details about
the meeting.
4. Click OK to save the event.
The event appears on your calendar.
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To edit an event:
Double-click an event in your calendar
to bring up the popover with the event
details, change the details you desire,
then click OK.
or
In the Date or Week views, drag the top or
bottom border of an event on the calendar
to change its duration.

To move an event:
Do one or more of the following:
n

n

On the calendar, drag the event from
one location to where you want it. For
example, you might want to move the
meeting that is been rescheduled from
one day to the next.
Double-click the event to open its
pop-up window, then change the event
details. You might need to use both
these techniques if an event is moved
both in day and time.

To delete an event:
In any calendar view, click an event
to select it, then press the Delete or
Backspace keys.
or
Double-click the event to bring up the
popover with the event details, then click
the Delete button.
If I’m going to be making a lot of changes
to my calendar events or reminders, I’ll often
choose to do them on my Mac, rather than
on an iOS device, because I still find it easier
to use a separate hardware keyboard and
mouse, rather than tapping and swiping on
a touchscreen. Perhaps I’m a dinosaur.
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Sharing Your
Calendars with Others
Perhaps the most useful thing about
iCloud’s calendar is its ability to share
your calendars and events with family,
colleagues, and friends who are also
using iCloud. You can allow other people
to share any of your calendars, and they
can ask you to share theirs. Of course, you
can still have calendars that are private to
you; iCloud will synchronize those private
calendars among all your devices, but
nobody else will be able to see them. You
can have any mix of shared and private
calendars you want.
There’s a difference between sharing and
inviting. When you share, you’re sharing
a whole calendar and all its events with
another iCloud user. When you invite,
you are offering to share a particular event
with another person, whether or not they
are using iCloud. Keep this difference in
mind when you decide which of the kinds
of collaboration you want. For example,
I’m comfortable in sharing most of my
calendars with my wife. But there might be
a particular meeting on my Work calendar
that I have with an editor; rather than share
the whole calendar, I’d be likely to simply
invite that editor to only that one meeting;
the invitation will be sent via email. When
the editor accepts the invitation, the event
appears for both of us.
iCloud’s calendar sharing uses the industrystandard CalDAV protocol, so you can
share calendars with people running
Calendar or variety of other calendar
programs on the Mac, and Microsoft
Outlook 2007 or later on Windows.
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To turn on calendar sharing:
1. On the calendar application of the
iCloud website, the Calendars List
will show a Share icon next to each
calendar A. A gray icon indicates
the calendar isn’t being shared, and
a green icon indicates that it is.
2. Click a gray icon to begin the sharing
process.
The Calendar Sharing popover
appears B.
3. In most cases, you’re going to want to
share the calendar privately with one or
more people. Click the Private Calendar
checkbox, then in the Add Person field
underneath, begin typing the person’s
name or email address. iCloud will do a
lookup of your Contacts list and provide
a pop-up menu with possible matches.
Click a contact with the mouse to
select it.
4. Click the person’s name to display the
pop-up menu with permissions. Decide
whether you want the person to be
able to View & Edit the calendar (that’s
the default choice) or to just be able to
View the calendar.
You might want to make a calendar
read-only (the View choice) if the
events of the calendar are ones that
you merely want to have the other
person informed about, but not to be
able to change, such as your business
travel plans.
5. (Optional) Repeat steps 3 and 4 for
anyone else you want to share the
calendar with.
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Shared calendars

Private calendars

A The icons next to the calendars tell you the
calendar’s sharing status.

B Enter the name and the sharing privileges for
each person with which you want to share the
calendar.

6. Click Share.
iCloud sends email invitations to the
people you chose C. If they accept the
invitation by clicking the Join Calendar
button in the email, they’ll be added to
the calendar.
7. Click OK.

C Invitees get an email invitation to your

calendars. Accepting the invitation is as easy
as clicking the Join Calendar button.

If you share one of your calendars, you
are considered to be the calendar’s owner.
Only you have the right to allow other people
to view or edit the calendar. Conversely, if you
are sharing someone else’s calendar you only
have the privileges they have allowed you.
And you can’t change those privileges for
yourself or anyone else.
To check the status of a calendar you
don’t own, click the green Share icon next to
it. iCloud will show you the Shared Calendar
Info popover D.

D You can see who is sharing calendars that you
don’t own.

To remove someone from calendar
sharing of the calendar you own, click the
Share icon, which brings up the Share
Calendar popover. The popover will show
you the people who are currently sharing the
calendar. Click the person whom you would
like to remove from sharing, then click the
red minus icon next to their name.
You can stop sharing a calendar
altogether by clicking the Share icon, which
brings up the Share Calendar popover, and
clicking the Stop Sharing button at the bottom.
You’ll get the usual iCloud confirmation dialog;
click Stop Sharing again.
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Subscribing to
Public Calendars
Besides the calendar events of yourself,
family, friends, and colleagues, you might
be interested in importing other kinds of
calendars. For example, you might want
to subscribe to an automatically updated
calendar for holidays in your country. Or
if you’re a sports fan, you might want the
playing schedule for your favorite team
to appear in your calendar. Maybe you
want the local weather, or the phases of
the moon. All of these, and many more,
are available as public calendars to which
you can subscribe. You’ll typically use
Calendar on the Mac to subscribe to one of
these calendars, but once you do, you can
choose to either keep that calendar local

A Apple maintains a list of public calendars.
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to your Mac, or to share it with the rest of
your devices via iCloud.
In this section, I’m going to show you how
to find a public calendar using Calendar,
subscribe to it, and then view it in your
calendar.

To subscribe to a public calendar:
1. Open Calendar on your Mac.
2. Choose Help > Find Calendar
Subscriptions.
Your default web browser will open
and bring you to Apple’s list of available
public calendars A. At the top of
the list, you can choose to view the
calendar feeds by Most recent, Most
popular, or Alphabetical.

3. Find the calendar to which you wish
to subscribe, then click the Download
button for that calendar.

B When you subscribe to a calendar in Calendar,
it shows you the calendar’s URL

Depending on the source of the calendar, you may be taken to a different
website where you can choose from
a number of calendars. If so, find the
calendar feed you want from that
website, then click to subscribe to it.
When you subscribe to a public calendar, Calendar shows you a dialog with
the URL of the calendar B.
4. Click Subscribe.
Calendar shows you a detail screen
about the calendar C.

C Subscribing to the calendar gives you its

information, and the Location pop-up menu allows
you to choose whether you want to subscribe to
it only on your local Mac, or via iCloud, to share it
with all your devices.

5. Do one or more of the following:
> Change the name of the calendar.
> From the color pop-up menu next to
the Name field, choose the color in
which you want the calendar’s events
to appear.
> Using the Location pop-up menu,
choose either iCloud or On My Mac.
This is probably your most important
choice in this dialog; choosing iCloud
will make the subscribed calendar
appear on all your devices.
> By default, most subscribed calendars have Alerts, Attachments, and
Reminders removed. In most cases,
I recommend you keep it that way.
> From the Auto-refresh pop-up menu,
choose how often you want the
calendar to refresh its data from the
original URL.
continues on next page
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6. Click OK.
The subscribed calendar appears
in Calendar. Double-click one of the
calendar events to see its details D.
You can find public calendars in many
more places than just Apple’s directory. For
example, in the U.S., all the Major League
Baseball clubs offer calendars that you can
download into Calendar. Many of them will
still refer to their calendars as working with
iCal, rather than Calendar; that’s fine, as
only the app name changed; the subscribed
calendar format didn’t.

D You can’t change the details of the events in a
subscribed calendar, but you can view them.

To delete a subscribed calendar:
1. In Calendar, click the Calendars button
in the upper left corner of the window
to display the Calendars list, if it isn’t
already visible.
2. Right-click the calendar you want to
delete, then choose Delete from the
shortcut menu E.
Calendar asks you if you’re sure you
want to delete the calendar.
3. Click Delete.
The calendar and its events and
reminders are deleted. If you had the
calendar shared on iCloud, the events
and reminders will disappear from all
your devices.
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E Right-click the calendar you want to delete,
then choose Delete from the shortcut menu.

Setting iCloud
Calendar Preferences
The iCloud Calendar application has two
preference panes, General and Advanced.
They closely mirror the preferences in
Calendar.

To set General preferences:
1. Click the Actions button, then choose
Preferences from the pop-up menu.
The General preferences appear A.
2. Choose one or more the following:

A The General Preferences screen lets you set
the calendar’s appearance, formats, and alerts.

> In the Appearance section, choose
whether you want to display 5 or 7
days per week, on which day of the
week you want the displayed week to
start, and how many hours at a time
you want to display in the Day and
Week views. If you select the Show
Birthdays calendar checkbox, the
Calendar application will show a new
Birthdays calendar, with information
taken from the Birthday field of the
people in your iCloud Contacts list.
> In the Formats section, choose the
Date format (your choices are MM/
DD/ YYYY, DD/ MM/ YYYY, and YYYY/
MM/DD) and the Time format (12 hour
or 24 hour). You can also choose the
Date Separator (/, -, or .) and the Time
Separator (: or .).
> In the Scheduling section, pick the
default calendar you want to use for
new events.
> In the Alerts section, if you select
Add a default alert to new events
and invitations, you can choose from
the pop-up menu the amount of time
before which the event is scheduled
that you’ll get an alert on your iCloudenabled devices.
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To set Advanced preferences:
1. Click the Actions button, then choose
Preferences from the pop-up menu.
2. Click the Advanced button in the
toolbar.
The Advanced preferences appear B.
3. Choose one or more the following:
> In the Time Zone section, if you select
Enable time zone support, you can
change the time zone for the whole
calendar, or just for individual events
that are different from the time zone
you’re in. If you choose this, a new
Time Zone pop-up menu will appear
in the New Event and Edit Event
popovers. Choosing a new time zone
from the pop-up menu will make
Calendar automatically change the
time of the event as shown on your
calendar to match the chosen time
zone. For example, if you’re on the
West Coast of the United States, you
have time zone support enabled,

and you set an event to occur at
3 p.m. Eastern time, the event will
automatically be translated to noon
Pacific time.
> In the Old Events section, select the
checkbox to hide events, and choose
the number of days after the event is
over you want the hiding to occur.
> In the Event Updates section, if you
select Ask before sending changes
to events (it’s on by default), iCloud
will check with you before it sends
out emails alerting people to changes
in events. This keeps changes in
your calendar from cluttering other
people’s mailboxes. Choosing Email
me shared calendar updates is
self-explanatory.
> In the Invitations section, choose to
get iCloud invitations as either in-app
notifications (they will appear in the
Notifications box in the toolbar) or
as emails.

B The Advanced Preferences screen is a potpourri of settings.
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Adding Reminders

A On iOS, you use two separate applications to
handle events and reminders.

What some of us call to-do items, Apple
refers to as reminders. In a major change
from the way reminders were handled
previously, events and reminders have now
been completely separated, with dedicated
Reminders apps for reminders, and with
events being handled by the Calendar apps.
The iCloud website, iOS devices, and the
Mac now all have you work with calendar
events and reminders in two entirely
separate apps, the Calendar and Reminders
apps, respectively A. On Windows you
can use Microsoft Outlook 2007 or later
(which calls reminders Tasks).
Reminders are different from calendar
events, in that they can be checked off as
completed; you can assign a priority to
them; and you can give them a due date
(but you don’t have to). Reminders with due
dates not yet marked as completed automatically remain in your Reminders list. All
of the Reminders apps allow you to maintain multiple reminder lists (for example,
Home, Work, and the like).
In this section, you’ll learn how to use the
iCloud website to work with reminders and
reminder lists. Remember that as you use
the iCloud website, changes you make
there will automatically propagate to the
rest of your iCloud-enabled devices.
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To add and edit Reminders
on the iCloud website:
1. In your web browser, open the Reminders app on the iCloud website B.
The Reminders app appears C.

B You’ll find the Reminders app on the iCloud
web site.

Search box
Reminder Lists

New Reminder List

Edit Reminder List

Reminders area

Show/Hide Calendar

C The Reminders app works very much like the similar apps for iOS and Mac.
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New Reminder

D Type your new reminder.

2. Click to select the reminder list you
want your new reminder to appear
in and then double-click in an empty
area of the Reminders pane.
or
Click the New Reminder button.
The insertion point appears in the line
below the last reminder D.
3. Enter the reminder, then press Return.
4. (Optional) Click the Details button to
bring up the Details popover E, then
do one or more of the following:

E The Details popover allows you to make
changes to your reminders.

> If you want to assign a due date
to the reminder, in the Remind me
section, select On a day, then enter
a date and time in the fields that
appear. You can also choose if and
how often you want the reminder to
repeat from the pop up menu.
> If you like, you can change the
Reminder List for the reminder.
> From the Priority pop-up menu,
assign the reminder’s priority level
(None, Low, Medium, or High). If you
assign a priority, the reminder will
show the priority as an icon of one
or more exclamation points in the
Reminders pane.
> If you want, add a Note to the
reminder.
> You can delete the reminder by
clicking the Trash button.
continues on next page
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5. Click Done.
The changed reminder appears in the
Reminders pane, with information letting you tell the details at a glance F.
A faster way to delete a reminder is to
select it in the Reminders pane, then press
Delete or Backspace.
You can mark a reminder as completed
by clicking the checkbox next to it in the
Reminders pane. Completed reminders appear
in a Completed section at the top of each list,
and are aggregated in a separate Completed
Reminder List.
Entering a search term in the search box
and pressing Return or Enter does a search
across all your lists.
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F When you’ve edited the details of a reminder,

those details appear with the reminder name. In
this case, the reminder’s Medium priority is shown
with the two exclamation marks.

To add or edit a Reminder List
on the iCloud website:
1. In the Reminder application on the
iCloud website, click the New Reminder
List button.
A new Untitled reminder list appears,
ready for you to name it G.

G Type the name of your new reminder list.

2. Enter the new reminder list name, then
press Return or Enter.
3. (Optional) To edit a reminder list, click
the list name to select it, then click the
Edit button at the top of the Reminder
Lists column H. Do one or more of the
following:
> To delete the list, click the icon with
the red circle with a line through it.

H The Edit mode allows you to delete, edit, or
reorder your reminder lists.

> To rename the list, select the name
and type over it.
> To reorder the lists, click and drag the
handle at the right side of the list.

I Like calendars, you can share your
reminder lists.

When you are done editing, click the
Done button at the top of the Reminder
Lists column.
You can share your Reminder Lists with
other iCloud users. Click the Edit sharing
settings button next to a list I, then enter
their name in the Sharing Reminders popover
that appears.
I was thinking of adding a section to this
book called “Working with Your Reminders on
a Mac,” but using the Reminders app on the
Mac is so similar to using the iCloud website
Reminders app that I decided there was no
need to take up the space.
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Working with
Reminders on
Your iOS Device
As mentioned before, you work with
iCloud reminders on an iOS device in the
Reminders app, which was introduced with
iOS 5. In this section, you’ll see how to use
the Reminders app to set up a to-do. Adding
or editing a task in Reminders makes it
automatically synchronize with the rest of
your iCloud-enabled devices.

To set a reminder:

Show/Hide Reminders Lists
Edit reminders

A You’ll work

with your
tasks in the
Reminders app.
This is one of
my reminders
lists on my
iPhone.

1. Start the Reminders app.
The app appears, set to its default list A.
On the iPhone or iPod touch, you can
move between your different reminders
lists by swiping right or left in the list
name at the top of the screen, or by
tapping the Show/Hide Reminders
Lists button. On the iPad, with its larger
screen, you can see more information
at one time, including a handy minicalendar B. Tapping on a date in the
calendar shows you any reminders set
for that date C.
2. Tap the plus button to add a reminder.
In the list that you’re on, on the first
blank line, an insertion point appears.

B The Reminders app on the iPad gives

you a nice mini-month calendar, making it
easier to jump to future dates.

C On the iPad, when you tap on a date in the minicalendar, tasks associated with that date appear.
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3. Type the reminder title D.
4. (Optional) You can tap the Return key
and enter more tasks.
5. On an iPhone or iPod touch, tap the
Done button. On an iPad, tap somewhere other than the line you’re typing
in, or tap the Hide Keyboard key .
The new reminder appears in the list.
6. To adjust the reminder’s details, tap it in
the list. A Details screen or popover (on
the iPad) appears E.

D Enter the title for
your reminder.

If you tap Show More, you have the
opportunity to set the reminder’s
Priority, change its assigned reminders
list, or add Notes.
7. To set a due date or geographical
reminder, you can turn on either (or
both) Remind Me On a Day and At a
Location.

E On the Details
screen, you can
choose to set a
reminder date or
location, or you
can add other
information to the
reminder.

F If you choose

to be reminded at
a location, you
can also choose
whether that
reminder triggers
when you leave
or arrive at the
location.

If you choose On a Day, Reminders will
show you the standard date and time
picker. Choose when you want to be
reminded, then tap Done.
If you choose At a Location, the Location
screen will appear, showing your current
location, your Home and Work locations
from your iCloud Contacts list, and an
Enter an Address field. Tapping that field
allow you to either type an address, or
you get the standard blue plus button
that opens your Contacts list, from which
you can choose the location where you
want to be reminded. Pick a contact with
an address, and you’ll be returned to the
Details screen, which now shows the
contact name and address F. You’ll also
get two new options, When I Leave and
When I Arrive. Choose one of these.
8. Tap Done.
continues on next page
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Location-based reminders are associated
with the iPhone 4 and later. They don’t work
on earlier iPhones, the iPad, or iPod touch.
Reminders with location information still appear
on those other devices, but the locationspecific information doesn’t appear.
You can delete, edit, or reorder your
reminders by tapping the Edit button at the
top of the screen.

Reminders Versus the World
Reminders is a free app from Apple that enters an already very crowded field of iOS task
managers, many of which also have Mac application counterparts that they sync with. Examples
of apps with Mac versions include The Omni Group’s OmniFocus, Appigo’s ToDo, and Cultured
Code’s Things. Task managers that shine on iOS include BusyMac’s BusyToDo (which works with
their BusyCal desktop program); Toodledo, from the company of the same name, and WebIS’
Pocket Informant Pro. Reminders also competes with iOS apps that are front ends to Web-based
task management services, such as Remember the Milk’s eponymous app.
So how does Reminders stack up in this crowd? Well, it’s kind of the same situation as with
calendaring. The Apple app does the job, but has a set of features that will leave power users
wanting more, more, MORE! Reminders, based as it is around a simple list metaphor, doesn’t have
important features for hardcore task management warriors, such as the concept of grouping tasks
into projects, or the ability to organize a bunch of tasks and show you the most important next
action that needs doing. For devotees of the Getting Things Done or Franklin Covey organization
methods, Reminders is not going to cut the mustard.
Interestingly, if you do choose to use one of these more-powerful task managers, you can leverage
Reminders to make it easier to work with them. Apple is very picky about which apps can interface
with Siri, the voice activated assistant, but Reminders is one of them. Other apps can use the
default list created by Reminders, and can build in the ability to take information from that list into
their own data. So for example, I use Siri to create reminders all the time, which make a quick stop
in Reminders before being pulled into OmniFocus for iOS. Remember the Milk and Things have
similar features.
But let’s say that you don’t have such a complicated life, you don’t care about organizing tasks into
projects, and you just want a decent to-do list. My advice is that you start with Reminders. If you
find yourself after a while wanting more organizational control, there are plenty of apps in the App
Store that can scratch that itch, starting with the ones I’ve listed above.
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Reminders or Alarms?
With the advent of the Reminders iOS app, you now have more than one way to alert yourself
when things need doing. You can use the Reminders app, as described above. But for some
purposes, you might want to instead use the Alarm function of the iPhone’s Clock app. Let’s take
a look at the differences between the two approaches.
The Reminders app is associated with your iCloud calendars and to-dos, and as a result synchronizes across all of your devices. That’s great when you want that to happen, but sometimes you
don’t. For example, let’s say that you need to take a medication each evening. You could certainly
set up a Reminder for that, and it would appear on your Reminder List every day. That would tend
to clutter up the Reminder List, especially if you had similar routine reminders. When the Reminder
triggers, because it is associated with iCloud and synchronizes between your devices, you’ll get
alerts on all your devices, and you’ll need to dismiss those alerts on all devices. I’ve certainly found
it to be jarring when I had my iPhone, iPad, and Mac all in one room, and they all popped up a
Reminder alert and made a noise at the same time.
On the other hand, the Clock app only runs on the iPhone, which you often carry on your person,
and you can set it up to give you a recurring alarm (as well as setting as many different alarms
you need in a particular day). Because it’s not integrated with iCloud, there is no calendar clutter.
And the Clock app’s repeating function G has day-of-the-week options that the Reminders app
does not H. By the way, if you need multiple reminders in the same day, there’s a terrific app
called HabiTimer from Sciral that’s perfect for things that neither Clock nor Reminders does well,
like alerting you to take medications multiple times in a day.

G In the Clock

app, you have a bit
more flexibility in
terms of recurring
day-of-the-week
alarms.

H The Reminders
app allows you to
set reminders at
intervals up to a
year away.
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Managing
Notifications on
Mac and iOS
Earlier in this chapter, you’ve seen lots of
information about setting up and editing
events and reminders on iOS devices, the
Mac, and the iCloud website. But a large
part of the power of event notifications
is that they can take a proactive role in
your life, actively letting you know when
they come due. They do this through
notifications, which are banners, dialogs,
and sounds that appear on your devices.
You set up notifications when you are
creating an event or reminder, and they
are pushed to your various devices via
iCloud when those events and reminders
are synchronized.
There are two kinds of visual notification
that appear:
n

n
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Banners appear on the screen, hang
around for a moment or two, then
discreetly tuck themselves away A.
Alerts appear on the screen, but require
action from the user (such as a click on
a button) before they go away B.
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A This is the banner notification, with a somewhat
unsettling message.

B This alert notification requires you to click one
of the buttons before it leaves your screen.

Beginning with Mountain Lion on the
Mac and iOS 6, there is a central spot
for working with notifications, cleverly
called Notification Center. On the Mac,
Notification Center is available from within
all apps. By clicking an icon in the right
edge of the menu bar, the contents of
your screen slide to the left, showing you
a bar with your latest notifications. On iOS,
Notification Center is always available by
swiping down from the top of the screen
C. If you have your device configured to
work with Twitter and Facebook on the
operating system level, then Notification
Center will also show widgets that allow
you to quickly tweet and post to your
Facebook Wall. The iPhone also has
Notification Center widgets for Whether,
Stocks, and Sharing.

C Notification Center (shown here on an iPhone)
can show you notifications from many different
apps, allow you to post to Twitter and Facebook,
and can even give you the weather forecast.

On the Mac, Notification Center gets
configured through the Notifications pane
of System Preferences. On iOS, you use
the Notifications section of the Settings
app. On either operating system, you have
the ability to configure notifications on an
app-by-app basis. So, for example, on the
Mac you can have your Calendar events
appear as a banner, and your Reminders
appear as an alert, and have the opposite
setting on your iOS devices. The settings
are per device, so you can even have
different settings for your iPhone and iPad.
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To configure notifications on a Mac:
1. From the Apple menu, choose System
Preferences, then click Notifications.
The Notifications preference pane
appears D.
2. In the list on the left, find the app
for which you want to configure
notifications settings. If the app is down
at the bottom of the list in the “Not in
Notification Center” section, click and
drag it up to the “In Notification Center”
part of the list.

D On the Mac, set up your notification styles in System Preferences.
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3. On the right side of the preference
pane, do one or more of the following:
> Pick the kind of alert style you want
(None, Banners, or Alerts).
> Choose whether or not you want the
app’s alerts to appear in Notification
Center, and if so, how many items
(1, 5, 10, or 20) you wish to appear
there.
> Select the checkbox if you want an
incoming notification to put a numeric
badge on the app’s icon in the Dock.
> Choose whether or not you want an
alert sound to play when the notification comes in.
4. At the bottom of the preference pane,
from the Sort Notification Center
pop-up menu, choose Manually or By
time. I prefer manually, because that
keeps apps from moving around by
themselves in the list.
5. Close System Preferences when you’re
done configuring things.
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To configure notifications
on an iOS device:
1. Tap the Settings app, then tap
Notifications.
The Notifications Screen appears E.
2. Scroll the list of apps until you find the
one you want to configure, then tap it.
3. In the notification settings screen for
the app F, first make sure that the
Notification Center switch is turned on.
4. Set the number of recent items you
want to show in Notification Center.
5. Set the Alert Style you want the app
to use.
6. Different apps have different options
available, but Badge App Icon and
Sounds are two common settings.
Choose whether you want them on
or off.
7. Decide whether or not you want the
alert notification from this app to appear
in the lock screen of the iOS app; that
is, the screen that appears after you
wake the device but before you swipe
to unlock it.

E On iOS, you’ll make your decisions about
Notifications in the Settings app.

F Each app allows fine-grained choices
about how its notifications appear.
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Index
Numbers
1Password website, 5
10.7 Lion app names
Address Book, 21
iCal, 21
iChat, 21
Mail program, 21
10.8 Mountain Lion app names
Calendar, 21
Contacts, 21
Game Center, 21
Messages, 21
Notes, 21
Reminders, 21

A
Address Book app equivalents, 21
AirPrint, using with notes, 41–42
alarms versus reminders, 93
albums, downloading, 128
alerts versus banners, 94
aliases, using with mail, 36. See also
email aliases
Aperture library, importing Photo
Stream items into, 107
Aperture program, using Photo Stream
with, 108
app names and equivalents, 21
Apple IDs
associating user account
with, 10

multiple, 10
password, 10
requirement, 9
signing in with, 11–12
Apple Mail program. See also Macs
account setup, 19–20
actions button, 25
application window, 19
equivalents, 21
Folders list, 25
hiding Folders list, 26
hiding Mailboxes list, 26
hiding message list, 26
on iCloud website, 25
mail headers, 19
mailboxes, 25
message area, 19, 25
message list, 19, 25
refreshing messages, 26
resizing Folders list, 26
resizing Mailboxes list, 26
resizing message list, 26
search box, 19, 25
toolbar, 19, 25
viewing, 26

B
Back to My Mac. See also Macs
Bonjour protocol, 201
explained, 199

Index

203

Back to My Mac. (continued )
File Sharing, 200–201
IPsec protocol, 201
NAT-PMP support, 201
router support, 201
Screen Sharing, 200, 202
setting up remote access, 200
UPNP support, 201
using, 199–202
Wide Area Bonjour, 201
Back Up Now button, 152
backing up to iCloud. See iCloud
Backup
banners versus alerts, 94
Bcc field, including in messages, 37
Black Text bookmarklet, 169
Bonjour protocol, use with Back to
My Mac, 201
bookmark synchronization
configuring, 161–162
enabling, 161–162
explained, 159
bookmarklets for iOS
adding, 170–172
Black Text, 169
Clip to Evernote, 169
Edit popover, 170
explained, 169
installation, 169
running, 172
saving changes to, 172
Unicode Symbols, 169
Box website, 136
browser bookmarks, 4
browser synchronization, preparing
for, 160
BusyCal calendar, 66
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C
Calendar app
alternatives, 66
BusyCal alternative, 66
Calvetica alternative, 66
to-do items, 61
equivalents, 21
events, 60
Fantastical alternative, 66
reminders, 61
views, 60
Calendar preferences
Advanced, 84
Alerts, 83
Appearance, 83
Event Updates, 84
Format, 83
General, 83
Invitations, 84
Old Events & Reminders, 84
Scheduling, 83
Time Zone, 84
calendar sharing
checking status of, 79
features, 77
ownership, 79
removing someone from, 79
stopping, 79
turning on, 78–79
Calendars app, 4
calendars. See also public
calendars
creating on iOS devices, 64
creating on Macs, 63
editing on iOS devices, 65
editing on Macs, 65
sharing, 62

calendars on iCloud website
Actions pop-up menu, 68–69
adding, 70
Calendar view buttons, 68
Calendars list, 68–69
changing date views, 71–72
color picker, 70
creating, 68–69
Date selector, 71–72
deleting, 70
editing, 70
events, 73–75
Go to Today button, 68
hiding, 69
naming, 69
New Event button, 68
notifications, 68
viewing, 69
Year and Month selector, 68
Calvetica calendar, 66
canonical data, 14
Chrome browser versus Safari, 166
Clip to Evernote bookmarklet, 169
Clock app, using Alarm function
on, 93
Composing preferences, setting for
mail, 37
contact addresses, displaying maps
of, 51
contact groups
adding, 55
adding members to, 55
displaying members of, 55
features, 54
removing, 55
removing members from, 55
renaming, 55
contacts
adding, 52

adding fields, 52
adding from incoming mail, 34
adding to Find My Friends, 194
deleting, 53
editing, 52–53
searching, 51
selecting multiple, 53
sending email to, 51
viewing, 50
Contacts app Action menu items
contact cards, 56
Delete, 56
Import vCard, 56
Make This My Card, 56
New Contact, 56
Print, 56
Contacts app, 4, 21
Contacts app Preferences
Address Layout, 57
Automatically Format Phone
Numbers, 57
Display Order, 57
Sort Order, 57
control panel, downloading for
Windows, 15, 100

D
deleting
calendars on iCloud website, 70
events on iCloud website, 76
folders, 31–32
items from iCloud storage, 157
iWork documents from iCloud, 148
messages, 35
notes on Macs, 44
photos, 113–114
reminders, 87–88
saving sent, 35
subscribed calendars, 82
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devices. See also iOS devices
charging, 3
finding, 173
documents, synchronized, 4
Documents in the Cloud. See also
iWork documents
adding text shortcuts, 140
benefit, 141
configuring, 136–140
versus Dropbox, 138
enabling on iOS, 139–140
enabling on Macs, 138
features, 136–137
Keynote documents, 137
moving on iCloud website, 144
opening, 143
restrictions, 144
saving, 142, 144
synchronizing text shortcuts, 140
updating files, 140
Dropbox
versus Documents in Cloud, 138
website, 5, 42, 136

E
email. See also Mail app; messages
adding contacts from, 34
adding signatures to, 37
Archive icon, 28
Compose icon, 28
composing, 29
Delete icon, 28
filing, 31
forwarding, 30, 35
Move to Folder icon, 28
Reply icons, 28
replying to, 30
sending to contacts, 51
toolbar, 28
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email accounts. See mail accounts
email aliases, number of, 18. See also
aliases
Erase feature, invoking, 188
Erase Mac button, clicking, 192
events
creating on iCloud website, 73–75
deleting on iCloud website, 76
editing on iCloud website, 76
handling, 85
moving on iCloud website, 76
versus reminders, 61
saving on iCloud website, 75
setting up for Find My Friends,
197–198
Evernote website, 42, 169

F
FaceTime button, using with Find
My Friends, 196
Fantastical calendar, 66
Find My Friends app
accepting location requests, 195
adding contacts permanently, 194
contacting friends, 196
Directions button, 196
explained, 193
FaceTime button, 196
Friends tab, 195
locating friends, 195–196
opening Maps, 196
requirements, 193
setting up, 193
temporary events, 197–198
using, 193
Find My Mac services
accuracy of, 186
activating, 175–176
Erase feature, 188, 192
errors in Wi-Fi positioning, 186

explained, 174
Lock feature, 188
locking Macs remotely, 190–191
message for Lock screen, 190
playing sounds, 189
using, 186–192
using for stolen devices, 178
using passcodes, 190
finding devices, 173, 180–181
finding features, using, 178
Flickr website, 5
folders
adding, 31
deleting, 31–32
dragging, 31
naming, 31
forwarding email, 30, 35
friends. See Find My Friends app

G
Gallery, discontinuation of, 5
Game Center app, equivalent, 21
Google Chrome browser, 166
Groups mode, using with contacts,
54–55

H
hardware requirements, 7–8

I
iCal app equivalents, 21
iChat app equivalents, 21
iCloud
and Apple TV, 12
benefits, 2–3
browser bookmarks, 4
Calendars, 4
charging devices, 3
configuring on iOS devices, 11–12

configuring on Mac, 13–14
configuring on Windows PC, 15–16
Contacts, 4
control panel for Windows, 15
email, 4
explained, 2
features, 4
location services, 4
music, 4
Photo Stream, 4
preference pane, 13
Reminders, 4
safety, 3
services, 14
setup process, 13
signing into, 11
storage space, 149–151
synchronized documents, 4
System Preferences, 13
iCloud Backup, 148
restoring iOS devices from, 153
Setup Assistant, 153
turning on, 152
iCloud documents. See also iWork
documents
adding text shortcuts, 140
benefit, 141
configuring, 136–140
versus Dropbox, 138
enabling on iOS, 139–140
enabling on Macs, 138
features, 136–137
Keynote documents, 137
moving on iCloud website, 144
opening, 143
restrictions, 144
saving, 142, 144
synchronizing text shortcuts, 140
updating files, 140
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iCloud mail. See also mail accounts
email aliases, 18
versus MobileMe mail, 18
iCloud storage
backup options, 157
deleting items, 157
purchasing, 158
iCloud Tabs, using in Safari, 159,
163–165
icloud.com
account, 4
addresses, 10
email, 18
iDisk, discontinuation of, 5
IMAP email protocol, 18
iMessages. See also messages
delivery confirmations, 48
features, 46
sending on iOS devices, 47
sending on Macs, 47–48
versus text messages, 48
using with iPads, 48
using with iPod touch, 48
verifying conversations, 47
Instapaper read-later service,
160, 168
inviting versus sharing, 77, 79
iOS apps
Calendar, 21
Contacts, 21
Game Center, 21
Messages, 21
Notes, 21
Reminders, 21
iOS devices. See also devices
adding passcodes to, 183–184
configuring for locations, 179
configuring iCloud on, 11–12
finding, 180–181
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finding devices, 173, 186
finding features, 178
finding with Location Services, 177
locking remotely, 183–184
Lost Mode process, 183
mail accounts, 22–24
playing sounds on, 182
restoring from backups, 153
setting passcodes for, 178
updating locations of, 182
wiping remotely, 185
working with remotely, 182
iOS requirements, 7–8
iPhoto in Photo Stream, 104–107
iPsec protocol, use with Back to My
Mac, 201
iTunes, turning on iCloud Backup in, 152
iTunes in Cloud
automatic downloads, 117–118
configuring, 116–121
Download All button, 121
re-downloading items, 119–121
iTunes Match. See also music
adding computers to, 124–126
adding iOS devices to, 127
configuring, 122
cost, 122
creating Smart Playlists, 131–132
device management, 129
Download icons, 129
downloading music, 128
Duplicate icon, 129
Error icon, 129
features, 122
finding matched songs to upgrade,
131–132
Ineligible icon, 129
limitations, 123, 134
playing music, 128

Removed icon, 129
replacing lower-bit rate music, 133
requirements, 123
seeing status of items, 126
subscribing to, 124
updating music, 130–133
Waiting icon, 129
iWeb site publishing, discontinuation
of, 5
iWork documents. See also Documents
in the Cloud
creating folders for, 148
deleting, 148
downloading, 147
managing on iCloud website, 146–148
opening folders, 148
uploading, 148
iWork programs for iOS, 137
iWork screen
actions, 146
folders, 146
Keynote presentation file, 146
program tabs, 146

J
Junk mailbox, retrieving mail from, 32

K
Keynote documents, file sizes, 137

L
Lion app names
Address Book, 21
iCal, 21
iChat, 21
Mail program, 21
Location Services, 4
controlling, 175
determining locations, 177

explained, 174
finding iOS devices with, 177
overview, 177
setting time zones with, 176
turning off, 175
Lock button, clicking, 191
Lock feature, invoking, 188
Lock screen, entering message for, 190
locking devices remotely, 183–184
locking Macs remotely, 190–191
Lost Mode process
beginning, 183
modifying, 184
stopping, 184

M
Macs. See also Apple Mail program;
Back to My Mac
configuring iCloud on, 13–14
connecting over Internet, 199
erasing remotely, 192
locking remotely, 190–191
mail accounts, 18–21
playing sounds on, 189
using Notes app on, 43–44
mail accounts. See also iCloud mail
IMAP email protocol, 18
setting up on Macs, 18–21
setup on iOS devices, 22–24
Mail app. See also email; messages
account setup, 19–20
actions button, 25
application window, 19
equivalents, 21
Folders list, 25
hiding Folders list, 26
hiding Mailboxes list, 26
hiding message list, 26
on iCloud website, 25
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Mail app. (continued )
mail headers, 19
mailboxes, 25
message area, 19, 25
message list, 19, 25
refreshing messages, 26
resizing Folders list, 26
resizing Mailboxes list, 26
resizing message list, 26
search box, 19, 25
toolbar, 19, 25
viewing, 26
Mail preferences
Accounts, 36
aliases, 36
Composing preferences, 37
forwarding email, 35
General, 34–35
message previews, 35
Rules, 38
Vacation, 39
maps
showing for contacts’ addresses, 51
using with Find My Friends, 196
messages. See also email; iMessages;
Mail app
adding recipients, 29
deleting, 35
getting, 29
marking, 32
moving, 31
moving deleted, 35
printing, 34
refreshing in Mail app, 26
saving as drafts, 29
searching for, 33
selecting, 31
Show Bcc field, 37
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sorting, 33
UTF-8 Unicode, 37
viewing, 26
Messages app, equivalents, 21
mobile devices. See iOS devices
MobileMe conflicts, 14
MobileMe mail
email aliases, 18
versus iCloud mail, 18
MobileMe services
demise of, 5–6
Gallery, 5
iDisk, 5
iWeb site publishing, 5
OS X system synchronization, 5
third-party software
synchronization, 6
Mountain Lion app names
Calendar, 21
Contacts, 21
Game Center, 21
Messages, 21
Notes, 21
music, 4. See also iTunes Match
downloading, 128
playing, 128
updating with iTunes Match,
130–133

N
Notes app
accessing folders, 41
Accounts screen, 40
alternatives, 42
configuring on iOS devices, 41
creating notes on Macs, 44
creating on iOS devices, 41
default account, 41

deleting notes, 41, 44
editing notes on Macs, 44
emailing, 41
equivalents, 21
Evernote, 42
fonts, 41
printing, 41
Send button, 41
synchronized, 40
using on iCloud website, 45
using on Macs, 43–44
Notification Center, 95
notifications
alerts, 94
banners, 94
configuring on iOS devices, 98
configuring on Macs, 96–97
managing, 94–98

OmniFocus, 6
OS X system synchronization,
discontinuation of, 5

features, 99
importing items, 107
in iPhoto, 104–107
photo storage in cloud, 100
removing from iOS devices, 103
setting preferences, 106
setting up on iOS devices, 103
sharing, 109–112
supported formats, 100
system requirements, 100
using with Aperture, 108
viewing on Apple TV, 12
Photobucket website, 5
photos, deleting, 113–114
pictures. See Photo Stream
printing
messages, 34
notes, 41–42
Printopia 2 website, 42
public calendars. See also calendars
deleting subscribed, 82
finding, 82
subscribing to, 80–82

P

R

passcodes, setting for devices, 177,
183–184, 190, 192
PC
configuring iCloud on, 15–16
requirements, 8, 16
people. See Find My Friends app
Photo Stream, 4
automatic upload from iOS devices,
105
disabling, 106
drawbacks, 103
enabling, 106
enabling on Macs, 101–102
enabling on PCs, 101–102

Readability read-later service, 160, 168
Reading List
All items, 168
Unread items, 168
using in Safari, 163, 167–168
read-later services
Instapaper, 160
Readability, 160
recipients, adding to email, 29
Reminder lists
adding on iCloud website, 89
editing on iCloud website, 89
sharing, 89

O
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Reminders, 4
reminders
adding, 85–89
adding on iCloud website,
86–89
adding to calendar, 61
versus alarms, 93
editing on iCloud website,
86–89
handling, 85
making as completed, 88
setting on iOS devices, 90–92
Reminders app
assigning due dates, 87
deleting reminders, 87–88
Details popover, 87
Edit Reminder list, 86
equivalents, 21
features, 92
New Reminder list, 86
priority levels, 87–88
Reminder lists, 86
reminders area, 86
search box, 86
searching lists, 88
Show/Hide Calendar, 86
remote access, setting up, 200
replying to email, 30
restoring iOS devices from
backups, 153

S
Safari browser
bookmark management, 160
bookmark synchronization, 159,
161–162
bookmarklets for iOS, 169–172
versus Chrome, 166
iCloud Tabs, 159, 163–165
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Reader feature, 168
Reading List, 163, 167–168
viewing devices, 163
searching
contacts, 51
for messages, 33
services, turning off, 12
sharing
calendars, 77–79
versus inviting, 77, 79
Photo Stream, 109–112
Reminder lists, 89
shortcuts, adding in Documents in
the Cloud, 140
Show Bcc field, including in
messages, 37
signatures, adding to outbound
mail, 37
Smart Playlists, creating in iTunes
Match, 131–132
SMS text messaging, 46
Snell, Jason, 130
software requirements, 7–8
songs, playing from iCloud, 128
sorting messages, 33
sounds
playing on devices, 182
playing on Macs, 189
stolen devices, finding, 178
storage space, 149–151
checking availability, 154
managing, 154–157
SugarSync website, 136
system requirements, 7–8
iTunes Match, 123
for Macs, 13
Photo Stream, 100
for Windows PCs, 16

T

W

tabs. See iCloud Tabs
task managers, 92
text messaging, 46, 48
text shortcuts, adding in Documents
in the Cloud, 140
TextExpander website, 140
to-do items, adding to calendar, 61
tracks, downloading from iCloud, 128

websites
1Password, 5
Box, 136
control panel for Windows, 15
Dropbox, 5, 42, 136
Evernote, 42, 169
Flickr, 5
Instapaper read-later service, 160, 168
Photobucket, 5
Printopia 2, 42
Readability read-later service, 160,
168
read-later services, 160
SugarSync, 136
TextExpander, 140
Weebly, 5
Windows PC
configuring iCloud on, 15–16
requirements, 8, 16

U
Unicode Symbols bookmarklet, 169
UTF-8 Unicode, using with
messages, 37

V
Vacation preferences, setting for
mail, 39
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